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2.2. Manipulation dans l'Espace 3D (Manipulation in 3D Space) 
Vous pouvez faire beaucoup de choses avec l'Object sélectionné dans votre monde virtuel. Vous pouvez le tordre, le rendre 
plus grand ou plus petit, l'utiliser comme forme de tour (Spin), modifier sa forme, etc. . Ce chapitre vous présente la façon 
d'appliquer ces actions sur vos Objects. 
 

Comme vous l'observerez beaucoup avec Blender, il n'y a jamais qu'un "seul chemin" pour exécuter ces choses. Pour les 
utilisateurs occasionnels, il y a toujours les menus sensibles au contexte. Pour les utilisateurs plus expérimentés, il y a les 
raccourcis claviers.  

 

Les Options du menu Object 
Avec un Objet sélectionné dans la Vue 3D, la barre des menus propose les options View, Select et Object. Cliquez sur l'option 
Object pour manipuler l'Object. Le menu qui apparaît contient l'entrée Transform . Cette entrée Transform  donne accès à un 
sous-menu qui vous propose des sélections (et leur raccourci à droite) pour manipuler l'Object. Vous y trouvez entre autre les 
options Grab/Move, Rotate, Scale, Convert to Sphere, Shear, Warp , Push/Pull et etc. ..  
 

Comme il existe aussi des raccourcis claviers pour exécuter ces actions, lisez le paragraphe suivant.  
 

2.2.1. Les Raccourcis Claviers (Hotkeys) 
 

L'outil Grab/Move 
Mode : mode Object / mode Edit  – Raccourci : G – Menu : Object>Transform>Grab/Move.  

 

L'une des façons les plus rapides de déplacer des choses dans un espace 3D est d'utiliser G. Presser ce raccourci fait passer en 
mode de transformation Grab/Move où l'Object (ou donnée) sélectionné(e) est déplacé en accord avec la position du pointeur 
de la souris. La distance entre le pointeur de la souris et l'Object manipulé n'a pas d'effet.  

 

Options 
• LMB  : Confirme le mouvement et laisse l'Object (ou la donnée) à sa position actuelle à l'écran.  
• RMB   :  Abandonne le mouvement et ramène l'Object (ou la donnée) à sa position originale.  
 

Voyez la suite du paragraphe sur les manipulations dans l'espace 3D pour les options supplémentaires disponibles dans les 
modes de transformation.  

 

L'outil Rotate 
Mode : mode Object / mode Edit  – Raccourci : R – Menu : Object>Transform>Rotate. 
 

Presser R fait passer en mode de transformation Rotate où l'Object (ou donnée) sélectionné(e) est mis en rotation en accord 
avec la position du pointeur de la souris. Ce mode utilise l'angle entre le point de pivot et le pointeur de la souris comme angle 
de rotation, donc déplacer la souris au plus loin de l'Object (donnée) procurera une précision beaucoup plus grande (c'est à dire 
que le mouvement de la souris affectera moins la rotation, pour une même distance de déplacement de la souris).  
 

Options 
• LMB  : Confirme la rotation et laisse l'Object (ou la donnée) avec sa position actuelle à l'écran.  
• RMB   :  Abandonne la rotation et ramène l'Object (ou la donnée) à sa rotation originale.  
• R (mode Trackball )  : Presser de nouveau R pendant que vous êtes déjà en rotation bascule le mode de rotation entre une 

rotation à axe unique (soit aligné sur l'écran, soit sur un axe précis) et une rotation à deux axes de type Trackball . En 
mode Trackball , la rotation de l'Object est contrôlée à la fois par les positions X et Y du pointeur de la souris, comme 
pour le mode Trackball de rotation d'une Vue 3D. Ceci peut être une façon rapide de faire pivoter un Object sur place, 
sans avoir besoin de modifier la rotation de la vue pendant l'ajustement.  

 

Voyez la suite du paragraphe sur les manipulations dans l'espace 3D pour les options supplémentaires disponibles dans les 
modes de transformation.  
 

L'outil Scale 
Mode : mode Object / mode Edit  – Raccourci : S – Menu : Object>Transform>Scale. 
 

Presser S fait passer en mode de transformation Scale où l'Object (ou donnée) sélectionné(e) est agrandi(e) ou réduit(e) en 
accord avec la position du pointeur de la souris. La taille de l'Object (donnée) sera augmentée quand le pointeur de la souris 
s'éloigne du point de pivot, et sera réduite si le pointeur de la souris se rapproche du point de pivot. Si le pointeur de la souris 
traverse le côté opposé de l'Object par rapport au point de pivot, le retaillage continuera dans une direction négative, en 
produisant un Object (donnée) inversé(e) (Flipped). La précision du retaillage est déterminée par la distance entre le pointeur 
de la souris et l'Object (donnée) quand le retaillage commence.  
 

Options 
• LMB  : Confirme le retaillage et laisse l'Object (ou la donnée) à sa taille actuelle à l'écran.  
• RMB   :  Abandonne le retaillage et ramène l'Object (ou la donnée) à sa taille originale. 
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Voyez la suite du paragraphe sur les manipulations dans l'espace 3D pour les options supplémentaires disponibles dans les 
modes de transformation. 
 

L'outil Precision 
Mode : mode Object / mode Edit  – Raccourci : CTRL, SHIFT . 
 

Maintenir enfoncé en plus CTRL  (mode Snap) ou SHIFT  (mode Precise) pendant l'une des manipulations précédentes 
permet de contrôler plus finement la précision.  
 

L’Outil Snap 
Mode : mode Edit  – Raccourci : SHIFT TAB . 
 

Cet outil est limité au mode Edit  et ne peut être associé qu'aux outils Grab/Move et 
Rotate.  Il est activé via un bouton à bascule dans l'entête de la Vue 3D (image ci-
contre) ou via le raccourci SHIFT TAB .  
 

Quand il est activé, un menu déroulant apparaît pour vous permettre de modifier le mode de l'outil Snap. 
 

Quand l'outil Snap est activé, passez en mode de transformation (Grab/Move ou Rotate) comme d'habitude 
(raccourcis, menus ou Manipulateurs), déplacez votre souris près du vertex que vous voulez 'coller' (snap) et 
appuyez CTRL . Si vous êtes suffisamment près d'un vertex, un petit cercle apparaîtra autour de la cible du 
'collage' et votre sélection s'y 'collera'. 
Vous pouvez déplacer votre souris aux alentours tout en maintenant CTRL  enfoncé pour sélectionner des 
cibles différentes pour le 'collage' (Attention : sur des Maillages importants, ceci peut devenir un peu lent.  

 

 

Exemples des Modes de l'outil Snap 
 

Les images suivantes démontrent les différents modes de l'outil Snap.  

  
 
Cette première image montre 
la position de départ du 
Maillage.  
 

Dans cet exemple, le plan plus 
petit sera 'collé' au vertex 
inférieur gauche du plan le 
plus grand.  

Mode Closest 
En utilisant ce mode, le plan 
sélectionné se 'colle' avec son 
propre vertex inférieur gauche, 
qui était celui le plus proche du 
point de collage visé. C'est le 
mode par défaut, adapté à la 
plupart des situations. 

Mode Center 
En utilisant ce mode, le plan sélectionné se 'colle' en utilisant 
la position du point de rotation. Dans ce cas, pour mieux 
illustrer la façon dont cela fonctionne, ce point a été réglé sur 
3D Cursor. Utiliser le mode Center de l'outil Snap avec le 
point de rotation 3D Cursor est la méthode de collage qui 
offre la plus grande souplesse.  
Note : Ce mode ne fonctionne pas avec l'outil Rotate. Dans 
ce cas, le mode par défaut est Median. 

 

  
Mode Median 

En utilisant ce mode, le plan sélectionné se 'colle' au niveau de son 
milieu (où le point de rotation utiliserait le centre Median Point). Ce 
mode est utile quand vous voulez centrer une partie d'un modèle sur un 
autre modèle.  

Utilisation de l'outil Snap avec des Contraintes  
L'outil Snap fonctionne aussi avec les contraintes 
de transformations. Cet exemple utilise l'outil Snap 
en mode Closest avec une contrainte selon l'axe X. 
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2.2.2. Le système Gestures (Reconnaissance de Mouvement) 
Mode : mode Object / mode Edit  – Raccourci : LMB  (en draguant).  
 

Les modes de Transformation 3D de Blender peuvent aussi être invoqués à l'aide de gestes tracés à la souris. L'outil est conçu 
pour déterminer le mode à utiliser en se basant sur un geste dessiné à la main. Après qu'un geste ait été dessiné comme décrit 
ci-dessous, relâchez LMB . Déplacez la souris sans presser aucun bouton, puis cliquez LMB  quand vous achevez l'effet que 
vous voulez. Pour abandonner, cliquez RMB , même si le mouvement a eu lieu dans la Scène. L'outil reconnaît trois gestes : 
Scale, Translate et Rotate.  
 

Mode Scale  
Pour activer le mode Scale, dessinez une courbe en forme de V en utilisant LMB . L'image ci-contre est 
un exemple de V dessiné à la souris. Il n'a pas besoin d'être exact, mais l'outil le reconnaîtra mieux si c'est 
le cas. Si le V contient un 'arrondi', il pourrait être interprété comme une requête pour le mode Rotate.  
 

Mode Rotate 
Pour activer le mode Rotate, dessinez une courbe en forme de C en utilisant LMB . L'image ci-contre 
est un exemple de C dessiné à la souris. Il n'a pas besoin d'être exact, mais l'outil le reconnaîtra mieux 
si la courbe est plus lissée. Si le C contient un 'angle droit', il pourrait être interprété comme une 
requête pour le mode Scale.  

 
 

Mode Translate  
Pour activer le mode Translate, dessinez une ligne (-) en utilisant LMB . L'image ci-contre L'image 
ci-contre est un exemple de - dessiné à la souris. Il n'a pas besoin d'être exact, mais l'outil le 
reconnaîtra mieux si la ligne est très droite. Si le trait diffère trop d'une ligne droite, il pourrait être 
interprété comme une requête pour le mode Rotate ou le mode Scale.  

 
 

 

2.2.3. Le Verrouillage des Axes (Axis Locking) 
 

Verrouillage Standard des Axes (Normal axis locking)  
Mode : mode Object/ mode Edit  (Translate, Rotate, Scale, Extrude) – Raccourcis : X, Y, Z. 
 

Blender possède une option très utile; si vous voulez retailler (S), faire pivoter (R), déplacer/translater (G) ou extruder (E) 
votre Object,  vous pouvez verrouillez ces opérations selon un (ou deux) axe(s) :  
Pressez simplement l’option de votre choix (par exemple, S pour retailler) et ensuite pressez X, Y ou Z pour verrouiller l’un 
des axes Globaux.  
 

Déplacement/Translation (Move/Translate)  
 
• Pressez G, puis X pour un déplacement le long de 

l’axe global X (gauche <-> droite).  
• Pressez G, puis Y pour un déplacement le long de 

l’axe global Y (avant <-> arrière).  
• Pressez G, puis Z pour un déplacement le long de 

l’axe global Z (haut <-> bas).  
 
  
 

Rotation (Rotate)  
 
• Pressez R, puis X pour pivoter autour de l’axe global 

X (de la gauche vers la droite).  
• Pressez R, puis Y pour pivoter autour de l’axe global 

Y (de l’avant vers l’arrière).  
• Pressez R, puis Z pour pivoter autour de l’axe global 

Z (du haut vers le bas). 
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Retaillage (Scale)  
 
• Pressez S, puis X pour retailler le long de l’axe 

global X (gauche <-> droite).  
• Pressez S, puis Y pour retailler le long de l’axe 

global Y (avant <-> arrière).  
• Pressez S, puis Z pour retailler le long de l’axe 

global Z (haut <-> bas).  

 
 

Verrouillage Inverse des Axes (Inverse axis locking)  
Mode : mode Object/ mode Edit  (Translate, Rotate, Scale, Extrude) – Raccourcis : SHIFT  X, SHIFT Y , SHIFT Z . 
 

Vous pouvez verrouillez deux axes à la fois, en axes globaux ou locaux. Pressez simplement SHIFT X , SHIFT  Y ou SHIFT  
Z pour verrouiller les deux autres axes (par exemple, SHIFT X , verrouille Y et Z).  
 

Déplacement/Translation (Move/Translate)  
• Pressez G, puis SHIFT X  pour un déplacement le 

long de l’axe global Y et de l’axe global Z (pas 
gauche <-> droite).  

• Pressez G, puis SHIFT Y  pour un déplacement le 
long de l’axe global X et de l’axe global Z (pas avant 
<-> arrière).  

• Pressez G, puis SHIFT Z  pour un déplacement le 
long de l’axe global X et de l’axe global Y (pas haut 
<-> bas).     

Rotation (Rotate)  
Pour la rotation, pressez SHIFT  ne fait aucune différence (sauf pour l’affichage des différents axes). Si vous voulez essayer de 
faire pivoter le cube en verrouillant deux axes, cela aura le même effet que si vous ne verrouilliez que le dernier axe. C’est une 
chose que vous apprenez en cours de mathématiques.  
Retaillage (Scale)  
• Pressez S, puis SHIFT  X pour retailler le long de 

l’axe global Y et de l’axe global Z (pas gauche <-> 
droite).  

• Pressez S, puis SHIFT Y  pour retailler le long de 
l’axe global X et de l’axe global Z (pas avant <-> 
arrière).  

• Pressez S, puis SHIFT Z  pour retailler le long de 
l’axe global X et de l’axe global Y (pas haut <-> 
bas).  

 

2.2.4. Les Espaces de Coordonnées (Co-ordinate Spaces) 
Le système de coordonnées utilisé pour manipuler un Object est par défaut le système de coordonnées Global, mais vous vous 
pouvez en choisir d’autres dans le menu Orientation :  

 

• Global : Ce système de coordonnées doit être suffisant pour la plupart des 
actions.  

• Local : Ce système de coordonnées est le système de coordonnées de l’Object.  
• Normal : ... ? 
• View : C’est le système de coordonnées relatif à votre Vue 3D courante.  

 

Ces espaces de coordonnées reposent essentiellement sur la différence qui existe entre le repère d'axes Global et le repère 
d'axes Local. Si vous passez par exemple dans une vue Camera (NUMPAD0), vous voyez deux repères d'axes XYZ  : celui 
qui correspond au repère d'axes Global est le repère d'axes du monde (World ). Habituellement, l'axe Z correspond au Haut<-
>Bas, l'axe X au Avant<->Arrière  et l'axe Y au Gauche<->Droite dans le monde.  
 

Mais tout Object que vous créez possède aussi son propre repère d'axes (Local). Par exemple, le repère d'axes d'un dé s'étend 
sur chacun de ses côtés : l'axe Z traverse les faces 1 et 6,  l'axe X traverse les faces 2 et 5 et l'axe Y traverse les faces 3 et 4. 
Mais, si vous placez la face 5 orientée vers le haut, l'axe X va de haut en bas et pas l'axe Z.  
 

Maintenant, quelle est la différence entre ces deux types de repères d'axes ?  
• Si vous créez un cube dans les vues Front  (NUMPAD1), Side (NUMPAD3) ou Top (NUMPAD7), le repère d'axes 

Global (World) et le repère d'axes Local (celui du cube) seront les mêmes.  
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• Si vous créez un cube dans la vue Camera (NUMPAD0) et que vous revenez dans la vue Front  (NUMPAD1), votre cube 
ne se tiendra pas droit et les deux repères seront orientés différemment.  

 

Pour résumer, le repère d'axes Global est toujours fixe par rapport au monde (World ) (et en visualisation dans les vues Front , 
Top et Side), et le repère d'axes Local d'un Object dépend de l'orientation de cet Object par rapport au monde (World). 
 

Vue Locale et Vue Globale (Local or Global View) 
Mode : mode Object ou mode Edit  – Raccourci : NUMPAD/  - Menu : View > Local View (ou Global View).  
 

Le menu View permet de basculer entre le mode de vue Local et le mode de vue Global. Un Objet doit être sélectionné pour 
passer en mode de vue Local et il devient automatiquement le centre d'intérêt dans ce cas.  
 

Exemple 

  
 

Dans l'image de gauche (mode de vue Global), les boutons Layers sont visibles et le cube vert est sélectionné. L'image de 
droite (mode de vue Local) montre que le cube est devenu le centre d'intérêt et est centré dans la Vue 3D (les boutons Layers 
ont disparus). Cette fonction est pratique quand vous voulez vous concentrer sur un Objet unique et rien d'autre. Si une Scène 
possède des milliers d'Objets visibles, cela peut accélérer potentiellement l'interactivité car c'est le seul Objet visible.  
 

2.2.5. L'Edition Proportionnelle (Proportional Edit  Tool ou PET)  
Mode : mode Edit – Raccourcis : O / ALT O  / SHIFT O  – Menu : Mesh>Proportional Editing.  
 

Quand vous travaillez avec une géométrie dense, il peut devenir difficile d'effectuer des ajustements subtils aux vertices sans 
générer des bosses et des faux-plis à la surface du modèle. Quand vous rencontrerez de telles situations, utilisez l'outil d'édition 
proportionnelle (PET). Il agit comme un aimant pour déformer doucement la surface du modèle, sans créer de bosses et de 
faux-plis, en modifiant non seulement les vertices sélectionnées mais également les vertices non sélectionnés dans un rayon 
d'action donné. 
 

Le menu du mode Proportional Editing est disponible en mode Edit dans l'entête de la Vue 3D : 
 
Off  : Le Proportional Editing  est désactivé (Off), seuls les vertices sélectionnés seront affectés.  
On : Les vertices autres que le vertex sélectionné sont affectés, à l'intérieur d'un rayon d'action donné.  
Connected (ALT O ): Le mode Connected autorise la détection de connexion dans une géométrie.  

 
Dans ce mode, plutôt que d'utiliser seulement un rayon d'action, le 
Falloff  proportionnel se propage à travers la géométrie connectée (image 
ci-contre).  
 
Ceci veut dire que vous pouvez facilement éditer proportionnellement 
les vertices dans un doigt d'une main, sans affecter les autres doigts, 
puisque bien que ces autres vertices soient proches spatialement, ils sont 
trop éloignés topologiquement parlant en suivant les connexions par 
arêtes du maillage. 
 
Cette option fonctionne sur les maillages et les courbes 2D (quoique 
incorrectement pour ces dernières).  
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Falloff  : Pendant que vous éditez, vous pouvez modifier le 
profil utilisé pour la courbe, soit en utilisant le sous-menu 
Mesh>Proportional Falloff, soit en utilisant le menu Falloff 
de la barre d'outils (image ci-contre) ou soit en pressant SHIFT 
O pour basculer entre les différentes options. 
 
 
 
Les diverses options de Falloff  sont illustrées ci-dessous :   
 

 
Constant, No Falloff 

 
Linear Falloff 

 
Sharp Falloff 

 
Root Falloff 

 
Sphere Falloff 

 
Smooth Falloff 

 

Influence : Vous pouvez augmenter ou diminuer le rayon de l'influence (image ci-
contre) de l'édition proportionnelle avec la roue de la souris (MW ) ou respectivement 
avec Page Up et Page Down. Quand vous ajustez le rayon, les vertices qui entourent 
votre sélection ajusterons automatiquement leur position en accord.  
 

Exemples : 
Passez dans une vue Front  (NUMPAD1) et activez le mode Grab avec G. Quand 
vous draguez le vertex vers le haut, notez comment les vertices proches sont dragués 
de concert avec lui. Quand vous êtes satisfait du placement, pressez LMB  pour fixer 
la position. Si vous n'êtes pas satisfait, abandonnez l'opération et revenez à votre 
maillage tel qu'il était avant avec RMB  ou ESC.  
  
Vous pouvez utiliser l'outil PET pour produire des effets 
impressionnants de concert avec les outils Scale (S) et Rotate 
(R), comme dans l'image du paysage présentée ci-dessous : 

Combinez ces techniques avec la peinture de vertices 
(Vertex Paint) pour créer des paysages fantastiques. L'image 
ci-dessous montre le résultat d'une édition proportionnelle 
après l'application de textures et d'un éclairage. 
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2.2.6. Le Panneau Transform Properties  
Mode : mode Edit  ou mode Object – Raccourci : N – Menu : Object>Transform Properties.  
 

Le panneau flottant Transform Properties est une boîte de dialogue indépendante du mode en cours, c'est à dire qu'elle peut 
continuer à être visible pendant que vous exécutez d'autres activités. Cette boîte de dialogue est continuellement mise à jour. 
Par exemple, si vous faites pivoter un Object, le champ Rot sera mis à jour en temps réel.  
 

Options du panneau Transform Properties (en mode Object) 
 
• OB: : Le nom de l'Object.  
• Par: : Le nom de l'Object parent s'il existe. En entrant ici un nom, vous assignez un 

Object parent. Le nom doit correspondre à un Object existant; si ce n'est pas le cas 
alors le nom est effacé du champ.  

• LocX: , LocY: , LocZ:  : L'emplacement de l'Object en coordonnées Globales 
relativement au centre de l'Object.  

• RotX: , RotY: , RotZ:  : L'orientation de l'Object relativement au centre de l'Object.  
 

• ScaleX:, ScaleY:, ScaleZ: : La taille de l'Object relativement au centre de l'Object. Chaque Object (cube, sphère, etc.), 
quand il est créé, possède une taille (ou échelle) d'une unité Blender dans toutes les directions depuis son centre. Pour 
rendre l'Object plus grand ou plus petit, vous le retaillez selon la direction désirée. 

• DimX: , DimY: , DimZ:  : Les dimensions de base de l'Object (en unités Blender) d'une arête à l'arête opposée, comme s'il 
était mesuré avec une règle. Pour des surfaces multi-facettées, ces champs donnent les dimensions de la boîte englobante 
(pensez à une boîte d'emballage) juste assez grande pour contenir l'Object. 

• Link Scale : Si ce bouton est activé, la relation entre les valeurs X, Y et Z des champs Scale… et Dim… est toujours 
préservée. Modifier une valeur modifiera également toutes les autres changing avec le même facteur multiplicatif. 

 

Utilisez ce panneau soit pour éditer, soit pour afficher les propriétés de transformation de l'Object telles que la position, la 
rotation et/ou le retaillage (mise à l'échelle) et ceci inclut aussi le nom de l'Object et l'assignation d'un parent. Ces champs 
modifie le centre de l'Object et donc, affectent l'aspect de tous ses vertices et faces. 
 

Note sur les courbes IPO : Les valeurs de position, de rotation et de taille peuvent aussi être affectées par une image-clé IPO; 
donc, s'il y a des images-clés IPO associées avec l'Object, assurez –vous de les remettre à zéro (reset) après avoir effectué des 
modifications dans ce panneau, ou vos modifications seront perdues quand le cellos sera modifié (les images-clés IPO écrasent 
les propriétés réglées manuellement).  
 

Quelques champs disposent de fonctionnalités supplémentaires, telles que des zones de défilement (scroll). Quand vous 
essayez d'éditer ces types de champs, il est plus facile d'utiliser SHIFT LMB  au lieu d'uniquement LMB . Après que vous ayez 
édité un champ, cliquez en dehors de la zone d'édition du champ (ou tapez ENTER) pour confirmer les modifications; ces 
modifications seront immédiatement reflétées dans la fenêtre d'affichage. Pour abandonner, tapez ESC.  

 

Verrouillage des Propriétés Transformables (Transform Properties Locking) 
La fonction verrouillage des champs Location, Rotation et Size vous permet de contrôler une propriété de transformation, 
uniquement à partir du panneau Transform Properties. Une fois qu'un verrouillage a été activé, toutes les autres méthodes 
utilisées pour une transformation sont bloquées. Par exemple, si vous verrouillez le champ LocX alors vous ne pouvez pas 
utiliser la souris pour déplacer l'Object le long de l'axe X. Toutefois, vous pouvez toujours le déplacer en éditant le champ 
LocX. Considérez la fonction de verrouillage (locking) comme une contrainte rigide seulement modifiable dans ce panneau  .  
Pour verrouiller un champ, cliquez sur l'icône cadenas à gauche du champ. Le champ est déverrouillé si l'icône apparaît sous la 
forme  et il est verrouillé si elle apparaît sous la forme .  
 

  
 
 


